
wózek
dziecięcy
Praca Bad Mother, którą w języku polskim ochrzciłem mianem Wyrodnej 
matki, została zainspirowana fotografią Alexandra Rodchenki Schody, 
ukazującą kobietę wnoszącą po stopniach dziecko. Obraz ten zwrócił moją 
uwagę przez wzgląd na swoją wysoką kontrastowość oraz ascetyczne piękno. 
W swojej interpretacji postacie zastąpiłem staczającym się po schodach 
czarnym wózkiem, za co odpowiedzialną uczyniłem tytułową matkę, 
prawdziwą bohaterkę sceny. Praca ta, choć wyróżniona na forum krajowym i 
zagranicznym, nie wymaga de facto szczególnych umiejętności modelarskich, 

o czym mam nadzieję 
przekona niniejszy artykuł, 
opisujący poszczególne 
etapy jej przygotowania.
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Przed rozpoczęciem prac nad wózkiem zebrałem szereg tzw. ilu-
stracji i zdjęć referencyjnych, ukazujących interesujący mnie 
model. Działania takie są powszechne i pozwalają nam zachować 
nie tylko właściwe proporcje danego przedmiotu, ale i wyposażyć 
go w niezbędne detale, jakie posiada w świecie rzeczywistym.

Modelowanie rozpocznijmy od kół, a dokładniej – opony, któ-
rą to stworzymy za pomocą Bezier Circle (nazwa domyślna – Cu-
rve Circle). Aby nadać jej odpowiednią grubość, dodajmy do sce-
ny jeszcze jedną krzywą Bezier Circle, po czym jej nazwę (w mo-
im przypadku jest to kolo) wpiszmy do paska BevOb naszej opo-
ny. W ten sposób zyska ona grubość równą średnicy koła (ilu-
stracja 1.), które to z kolei, w razie potrzeby, możemy skalować 
do czasu uzyskania najlepszego efektu.

Pora na przygotowanie obręczy. W tym samym miejscu, w 
którym utworzyliśmy oponę, dodajmy do sceny Mesh Circle (nie 
zmieniajmy nic w jego domyślnych ustawieniach, ważne jest bo-
wiem, aby był złożony z 32 wierzchołków), po czym (klawisz 
[E]) nadajmy mu niewielką szerokość oraz grubość (uwaga – wy-
korzystajmy do tego celu kombinację [Alt]+[S], zamiast zwykłe-
go skalowania). Następnie wzdłuż jego powierzchni utwórzmy 
dwa Edge Loop’y ([Ctrl]+[R]) i przesuńmy je w kierunku krawę-
dzi obręczy (ilustracja 2.).

Tak powstałe przy brzegach dwa rzędy powierzchni zaznacz-
my ([Alt]+[PKM]), po czym wytłoczmy je ([E]) i delikatnie wy-
brzuszmy (kombinacją [Alt]+[S]) tworząc wyżłobienie dla przygo-
towanej już wcześniej opony. Na koniec pozostaje nam jeszcze do-
danie jednego Edge Loopa na środku wewnętrznych ścian obręczy 
i przeskalowanie tak powstałego rzędu wierzchołków w kierunku 
środka koła. Rezultat naszych działań ilustruje obrazek 3.

Aby nasz model stał się mniej kanciasty, nadajmy mu gładką 
powierzchnię (opcja Set Smooth z menu Specials wywoływane-
go klawiszem [W]) oraz dwa modyfikatory – SubSurf i Edge Split, 
zachowując ich domyślne ustawienia.

Nadszedł czas na uzupełnienie koła o szprychy, których 
liczba w moim projekcie wynosi 28. Po dokładniejszej analizie 
odkryjemy, iż ich układ determinowany jest przez położenie rap-
tem czterech nich, wzajemnie się krzyżujących, ulokowanych po 
dwa z każdej strony obręczy. Naszą pracę rozpocznijmy od wy-
brania takiego widoku na scenę, który zapewni nam widok całe-
go przygotowanego przez nas koła ([1], [3] lub [7] z klawiatury 
numerycznej). Po jego zaznaczeniu umieśćmy kursor 3D w środ-
ku obiektu ([Shift]+[S], opcja Cursor>Selection), a następnie do-
dajmy do sceny Mesh Cylinder. Ponieważ stanie się on naszym 
wkrętem w szprychę, pracując w trybie Edit Mode zmniejszmy 
go, a następnie ulokujmy na środku obręczy po jej wewnętrznej 
stronie (ilustracja 4.).

Czas na powielenie naszego wkrętu; pozostając w trybie Edit 
Mode, zajrzyjmy do okna Mesh Tools, gdzie odnajdziemy opcję 
Spin Dup, tworzącą duplikaty aktywnego obiektu. Ustalmy opi-
sujące ją parametry na: 360 dla Degr (taki obrót zatoczą genero-
wane wokół kursora 3D duplikaty) i 27 dla Steps, odpowiadający 
liczbie tworzonych wkrętów (ilustracja 5.). 

Po wciśnięciu przycisku Spin Dup nasza obręcz powinna po-
siadać już 28 wkrętów, które stanowić będą dla nas wskazówkę 
co do lokalizacji szprych (rysunek 6.).

W trybie Object Mode dodajmy do sceny kolejny Mesh Cylin-
der (liczba wierzchołków nie powinna przekraczać 8), po czym 
dosuńmy go do pierwszego utworzonego przez nas wkrętu, 
zmniejszmy i wydłużmy w kierunku bliskim środka koła. Ponow-
nie korzystając z opcji Spin Dup, powielmy go trzykrotnie (Steps: 
3), o 40 stopni (Degr: 40), po czym przesuńmy zakończenia każ-
dej ze szprych zgodnie z ilustracją 7. (pierwsza winna krzyżować 
się z trzecią po lewej stronie koła, a druga z czwartą po prawej).

Tak przygotowane szprychy duplikujmy za pomocą narzę-
dzia SpinDup (Degr: 360, Steps: 7), likwidując nałożone na sie-
bie wierzchołki komendą Remove Doubles z okna Mesh Tools. Ko-
ło uzupełniamy o piastę, którą przygotowujemy z Mesh Cylinder, 
odpowiednio powielając krawędzie opcją Edge Loop i wytłaczając 
je, aż do uzyskania oczekiwanego kształtu (ilustracja 8.).

Zwróćmy uwagę, iż przednie koła naszego wózka różnią 
się od rozmiarów kół tylnych, dlatego też zaznaczmy wszyst-

Rysunek 1. Krzywa Curve Circle została pogrubiona o średnicę 
krzywej kolo pisanej w jej pasek BevOb

Rysunek 2. Utworzenie dwóch 
Edge Loopów na krawędziach ob-
ręczy koła

Rysunek 3. Gotowy kształt 
obręczy koła

Rysunek 4. Przeskalowany Mesh Cylinder został umieszczony 
po wewnętrznej stronie obręczy koła

Rysunek 5. Zestaw opcji narzędzia Spin Dup
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kie elementy wchodzące w jego skład, a następnie zduplikujmy 
je ([Shift]+[D]) i przeskalujmy, dbając, by szprychy, bądź opo-
na, nie zmieniły swej grubości w stosunku do oryginału (część 
obiektów, takich jak krzywe, skalujmy w trybie Edit Mode, pozo-
stałe jednak najlepiej jest powielić opcją SpinDup na nowo).

Ponieważ modelowanie kolejnych kół byłoby zbyt praco-
chłonne, zaznaczmy wchodzące w skład pierwszego z nich ele-
menty (najszybciej dokonamy tego poprzez ujęcie ich w ramkę 
za pomocą kombinacji [Shift]+[B]), a następnie utwórzmy dla 

nich grupę ([Ctrl]+[G], Add to New Group). Jej nazwę ustalimy 
z poziomu panelu Object przycisków Object Buttons [F7], gdzie 
odnajdziemy okienko Object and Links oraz interesujący nas pa-
sek GR. Czynność tę powtarzamy dla drugiego koła, dodając dwie 
nowe grupy do sceny za pomocą menu Toolbox ([Spacja]) i znaj-
dującej się tam zakładki Add>Group. Każde z kół umieszczamy 
w odpowiednich miejscach, łącząc piasty przednich i tylnych za 
pomocą dwóch brył Mesh Cylinder (ilustracja 9.).

Owe bryły stanowią podstawę dla metalowego koszyka, któ-
ry stworzymy za pomocą obiektu Plane. Wytłoczmy go i dodajmy 
dodatkowe Edge Loopy zgodnie z ilustracją 10.

Uzyskanie obiektu utworzonego z drutów byłoby karkołom-
nym zadaniem, gdybyśmy mieli tego dokonać ręcznie. Skorzy-
stajmy więc ze skryptu Soldid Wireframe, który odnajdziemy 
w menu okna Scripts Window (Scripts>Mesh>Solid Wireframe). 
Ustalmy interesującą nas grubość krawędzi obiektu (w moim 
przypadku wartość Thick wyniosła 0.03), po czym zainicjujmy 
skrypt. Nowo utworzony obiekt został umieszczony na scenie w 
miejscu bazowego Plane, który to możemy już usunąć.

Wymodelowanie kolejnych rur i uchwytów nie powinno na-
stręczać już zbyt wiele problemów. Pozostaje nam więc tylko przy-
gotować czarne taśmy, łączące je wszystkie ze sobą. Wykorzysta-
my do tego celu krzywe Bezier Curve, które po dodaniu do sceny 
odpowiednio wygniemy. Wymaga to uprzedniego wciśnięcia przy-
cisku 3D okna Curve and Surface, które to odnajdziemy w przyci-
skach Editing ([F9]) programu, umożliwiającego nam zmianę po-
łożenia poszczególnych węzłów krzywej na wszystkich osiach w 
przestrzeni. Nie obejdzie się również bez tworzenia nowych wę-
złów, a więc – wydłużania Bezier Curve, czego dokonujemy po-
przez zaznaczenie jej pierwszego lub ostatniego węzła i wciśnięcie 
klawisza [E] lub też za pomocą kombinacji [Ctrl]+[LKM]. Gotowy 
układ wszystkich krzywych przedstawia ilustracja 11.

Ponieważ tak utworzone krzywe są niewidoczne, należy 
nadać im odpowiednią szerokość i – przynajmniej złudnie – gru-
bość. W tym celu należy we wspomnianym przed chwilą oknie 
Curve and Surface wprowadzić dla opcji Extrude, Bevel Depth i 
BevResol stosowne do wielkości wózka parametry, które w mo-
im przypadku wyniosły odpowiednio 0.15 (szerokość krzywej), 
0.040 (jej prowizoryczna grubość, będąca w istocie zaokrągle-
niem powierzchni) i 10 (jakość owego zaokrąglenia).

Uwaga – edycja krzywych w Blenderze bardzo często pro-
wadzi do skręcenia uzyskiwanych za ich pomocą powierzch-
ni. Aby pozbyć się tego błędu, należy w trybie Edit Mode zazna-
czyć jej wszystkie węzły, po czym dodać doń modyfikator Hook 
([Ctrl]+[H], Add New, Empty). Teraz wystarczy już obracać krzy-
wą w trybie Object Mode do chwili zlikwidowania wszelkich za-
gięć, wieńcząc całą operację przyciskiem Apply umieszczonym 
w oknie modyfikatora Hook.

Praca nad dolną częścią wózka jest już zakończona. Czas na 
przygotowanie jego najważniejszej części, a więc łóżeczka dla 

Rysunek 6. Powielone wkręty obręczy

Rysunek 7. Sposób ułożenia szprych w kole wózka

Rysunek 8. Gotowa piasta koła Rysunek 9. Gotowe koła wózka
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dziecka, które wykonamy z obiektu Mesh Plane. Dodając i wy-
tłaczając jego krawędzie, przygotujmy kształt zbliżony do tego 
z ilustracji 12.

Zwróćmy uwagę, iż część krawędzi wózka wytłoczyłem deli-
katnie na zewnątrz. Pozostała, pozbawiona owego wybrzuszenia, 
posłuży nam do przygotowania daszku, co wymaga podjęcia kil-
ku prostych kroków. Na początek zaznaczmy dwa przeciwlegle 
leżące wierzchołki tuż obok początku i końca wytłoczonej czę-
ści krawędzi wózka, po czym umieśćmy między nimi kursor za 
pomocą kombinacji [Shift]+[S] (opcja Cursor>Selection); w dal-
szej kolejności zaznaczmy krawędzie wózka, tak aby wskazane 
przez nas wierzchołki stały się początkiem i końcem zaznacze-
nia (ilustracja 13.).

Przejdźmy do widoku, w którym ujrzymy nasz wózek od bo-
ku. Skorzystamy teraz z opcji Spin umieszczonej tuż obok pozna-
nego już wcześniej SpinDup, dla której wskażemy następujące 
parametry: Degr: 100, Steps: 4. Za jej pomocą doprowadzimy nie 
tylko do zduplikowania zaznaczonych krawędzi, ale i utworzenia 
powierzchni między nimi, które zaowocują powstaniem oczeki-
wanego dachu. Ponieważ daszek wózka jest pogięty i regularnie 
wklęsły, należy uzupełnić wygenerowane powierzchnie o dodat-
kowe krawędzie, które zostaną przesunięte, przeskalowane i wy-
gięte (najlepiej operacje te wykonać w trybie Sculpt Mode). Wy-
korzystamy do tego celu narzędzie Knife ([K], opcja Midpoints), 
za pomocą którego nakreślimy linie przecięć na zaznaczonych 
fragmentach wózka (ilustracja 14.). 

Gotowy wózek należy uzupełnić o dodatkowe elementy po-
kroju metalowych drucików na ścianach daszku, niewielką fal-
bankę wiszącą w jego górnej części, rączkę, czy logo firmowe, co 
nie powinno nastręczać zbyt wielu trudności. Ostatnim elemen-
tem jest kocyk dziecka, który powstanie za pomocą kilkukrotnie 
podzielonego obiektu Mesh Plane (funkcja Subdivide z wywoły-
wanego klawiszem [W] menu Specials). Zanim jednak zdecydu-
jemy się nadać mu odpowiedni kształt, rozpakujmy jego siatkę w 
trybie Edit Mode i widoku od góry za pomocą klawisza [U] (po za-
znaczeniu jego wszystkich krawędzi!) i opcji Project From View 
(Bounds), co ułatwi nam późniejsze oteksturowanie modelu. Po-
fałdowania kocyka najłatwiej przygotować w trybie Sculpt Mode, 
korzystając z dłut Draw, Smooth oraz Grab. Stosownie do potrzeb 
należy nadawać bryle dodatkowe poziomy Multires (okno Mul-
tires omawianego trybu), które umożliwią bardziej precyzyjne 
przygotowywanie pożądanych kształtów.

Na zakończenie pozostaje nam zebrać wszelkie elementy 
wchodzące w skład wózka dziecięcego do jednej, nowej grupy, co 
ułatwi nam jego późniejsze ulokowanie na stopniach schodów.

otoczenie
Przygotowanie otoczenia jest najprostszym elementem projek-
tu. Zacznijmy od stopni, które są niczym innym, jak odpowiednio 
przeskalowanym, uzupełnionym o kilka wytłoczonych krawędzi 
sześcianem Mesh Cube (ilustracja 15.).

Tak przygotowaną bryłę najwygodniej jest powielić za pomo-
cą modyfikatora Array. Podobnie jak w przypadku tworzenia grup 
ma to jedną podstawową przewagę nad zwykłym duplikowaniem 
obiektu – w każdej chwili możemy wprowadzać zmiany do mode-
lu bazowego, które potem zostaną automatycznie powielone na 
jego duplikaty.

Modyfikator Array generuje ciąg obiektów na dwa sposoby 
– co określoną liczbę jednostek bez względu na geometrię bry-
ły (funkcja Constant Offset) bądź też z jej uwzględnieniem (Re-
lative Offset). W naszym przypadku zdecydujemy się na tą dru-
gą, wprowadzając odpowiednie wartości parametrów X, Y (od-
powiadają one za przesunięcie modelu na określonych nazwą 
osiach) i Count (liczba utworzonych duplikatów, a więc stopni). 
Należy przy tym zwrócić uwagę, iż co drugi stopień posiada in-
ny układ płytek – możemy więc przygotować dwa stopnie w jed-
nym obiekcie, bądź też stworzyć nowy, odrębny obiekt, powiela-
jąc stopnie o dwukrotnie dalsze odległości (ilustracja 16.).

Pozostałe elementy otoczenia, jak ściana, murek, czy chod-
nik, przygotowujemy analogicznie do stopni, powielając proste 
bryły za pomocą modyfikatora Array. Jeśli jednak zajdzie po-

Rysunek 10. Kształt kosza ulokowanego przy kołach wózka

Rysunek 11. Rozmieszczenie krzywych, które staną się ta-
śmami wózka

Rysunek 12. Podstawowy kształt łóżeczka
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trzeba wprowadzenia delikatnych zmian do jednego z duplika-
tów w schemacie (pojedyncza płytka na placu, do którego pro-
wadzą schody, jest przekrzywiona), nie pozostaje nam nic inne-
go, jak utworzyć z kopii rzeczywiste modele, czego dokonujemy 
poprzez wciśnięcie przycisku Apply w opcjach modyfikatora Ar-
ray (ilustracja 16.).

lalka
U szczytu schodów znajduje się szmaciana lalka, która złożo-
na jest z raptem pięciu sześcianów Mesh Cube, wyposażonych 
w modyfikator SubSurf (ilustracja 17.). W przypadku jej tworze-
nia największą trudność sprawia przygotowanie włosów oraz su-
kienki, zdającej się ukrywać korpus zabawki.

Zacznijmy od włosów, które przygotowane zostały w wersji 
2.45 Blendera, a więc pozbawionej jeszcze narzędzi umożliwia-
jących generowanie wymyślnych fryzur. Ponieważ jednak pro-
jekt nie jest kompatybilny z nowymi wersjami Yaf(a)ray’a i Blen-
dera, postaram się pokrótce opisać, jak wyglądało ich stworzenie 
onegdaj, wskazując zarazem opcje służące do tego typu efektów 
obecnie.

Tak kiedyś, jak i dziś, pracę nad włosami rozpocząć nale-
ży od zaznaczenia grupy wierzchołków (Vertex Group), z których 
mają one wyrosnąć. Najlepiej operację tę przeprowadzić w trybie 
Weight Paint, zamalowując wirtualnym pędzlem na kolor czerwo-
ny te obszary, które stanowić mają największe skupiska włosów 
(kolor niebieski odpowiada powierzchniom pozbawionym owłosie-
nia). Pracując na Yaf(a)ray’owym buildzie Blendera bf-Blender 187 
przejdźmy do panelu Object ([F7]) i jego Physics Buttons, gdzie 
odnajdziemy okno Particles. Po wciśnięciu jedynego obecnego 
tam przycisku New rozpocznie się wysyłanie przez obiekt cząste-
czek, które jeśli aktywujemy opcję Static, przyjmą postać odcin-
ków, a więc prymitywnych jeszcze włosów. Zanim zajmiemy się 
ich ułożeniem, wprowadźmy widoczne na ilustracji 18. wartości, 
zwracając szczególną uwagę na opcje Amount (liczba włosów), Li-
fe i Normal (ich długość) oraz R.Life (parametr odpowiadający za 
losowe różnicowanie długości cząstek). Nie zapomnijmy przy tym 
o umieszczeniu nazwy wyodrębnionej przez nas grupy wierzchoł-
ków (odnajdziemy ją w panelu Editing – [F8] – w oknie Link and 
Materials przy napisie Vertex Groups) w polu Vgroup okna Partic-
les, co zdeterminuje powstanie włosów do tego właśnie obszaru.

Efektem naszych działań powinna stać się rozstrzelona na 
wszystkie strony fryzura lalki. Aby nadać jej bardziej odpowiedni 
kształt, należy umieścić w jej pobliżu obiekty Empty (dostępne 
w menu Toolbox), po czym każdemu z nich nadać odpowiedni ro-
dzaj pola z menu Fields okna Fields and Deflection, dostępnego z 
poziomu panelu Object (ilustracja 19.).

Rysunek 13. Zaznaczone krawędzie pozwolą nam utworzyć 
daszek nad wózkiem; kursor 3D umieszczony został w połowie 
długości pomiędzy wierzchołkami A i B 

Rysunek 14. Moment utworzenia cięcia zaznaczonej części 
siatki obiektu za pomocą narzędzia Knife

Rysunek 15. Prosty model jednego ze stopni schodów

Rysunek 16. Schody utworzone za pomocą powielenia pierw-
szego i drugiego stopnia modyfikatorem Array; przycisk Apply po-
zwala na przekształcenie wirtualnych duplikatów w rzeczywiste 
modele

Rysunek 17. Części lalki zbudowane za pomocą prostej edy-
cji sześcianów
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W przypadku Bad Mother wykorzystałem pola Wind i Sphe-
rical, ustalając za pośrednictwem parametru Strength ich siłę, 
Fall-Off – osłabienie wpływu wraz z odległością dzielącą pola od 
cząstki oraz MaxDist – zasięg wpływu danego Field. Efekt moich 
działań ilustruje rysunek 20.

Ustalanie kształtu fryzury za pomocą pól Fields jest niewy-
godne i nieefektowne, nic więc dziwnego, iż nowsze wersje Blen-

dera posiadają już narzędzia upraszczające owy proces. Przede 
wszystkim rozbudowie uległy okna poświęcone edycji cząste-
czek, choć nadal posiadają wymienione w poprzednich akapi-
tach funkcje. Liczbę włosów nadal regulujemy parametrem Amo-
unt, ich długość – wartością Normal, jednak aby cząstki przyję-
ły wygląd odcinków, musimy z menu okna Visualisation wska-
zać opcję Path. Co więcej, zamiast generować wysoką liczbę wło-
sów, możemy powielić już istniejące, do czego służy okno Chil-
dren; znajdziemy w nim m.in. menu determinujące z jakich czę-
ści obiektu wyrastać mają duplikaty (obok istniejących już czą-
stek – opcja Particles – lub ze wszystkich powierzchni modelu 
– opcja Faces) oraz parametr Amount ustalający ich liczbę dla 
każdego istniejącego już włoska (ilustracja 21.). 

Największą zaletą obecnego systemu jest jednak obec-
ność wirtualnego studia fryzjerskiego, które aktywujemy przy-
ciskiem Set Editable w Particles System. Teraz wystarczy już tyl-
ko przejść do trybu Particle Mode i wcisnąć klawisz [N], aby ko-
rzystając z całego zestawu narzędzi – grzebienia przesuwające-
go włosy (Comb), wygładzającego fryzurę (Smooth), tworzącego 
nowe włosy (Add), bądź wydłużającego wybrane (Length). Opcje 
te nie tylko zwiększają kontrolę nad końcowym efektem, ale i 
pozwalają na szybsze osiągnięcie rezultatów, które w wersji bf-
blender 187 wymagały długotrwałych zabiegów (ilustracja 22.).

Pora na przygotowanie sukienki dla leżącej na schodach lal-
ki. Działania, jakie podejmiemy, są analogiczne do tych, które to-
warzyszyły nam w czasie przygotowania kocyka dla leżącego w 
wózku dziecka. Na początek więc musimy przygotować prostą 
bryłę na bazie sześcianu Mesh Cube, której to siatkę odpowied-
nio rozpakujemy, tworząc wirtualne przecięcia ([Ctrl]+[E], opcja 
Mark Seam) na określonych krawędziach bryły (rysunek 23.).

Kolejnym krokiem jest jednoczesne dodanie zarówno po-
ziomów Multires, jak i określonych modyfikacji siatki obiektu w 
trybie Sculpt Mode aż do chwili uzyskania interesujących nas 
kształtów.

materiały, światło, kadr i rendering
Nadszedł moment, w którym nasza praca związana z modelowa-
niem obiektów dobiegła końca. Po ich skrupulatnym ułożeniu na 
scenie pozostaje nam tylko nadać konkretnym obiektom lub wierz-
chołkom odpowiednie nazwy materiałów oraz tekstury, przy czym 
dla większości z nich skorzystamy z uprzednio przygotowanych 
koordynatów UV, jakie powstały na skutek rozpakowania siatki 
bryły. Dokładna edycja cech materiału dokonana zostanie z pozio-

Ilustracja 18. Zestaw opcji prowadzący do powstania włosów lalki

Rysunek 19. Menu Field Type pozwala nam na wybór rodzaju 
sił kształtujących kształt wirtualnych włosów

Rysunek 20. Utworzona za pomocą pól Fields fryzura lalki

Rysunek 21. Najważniejsze opcje nowego systemu cząstek, odpowiadające za gęstość i długość generowanych włosów
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mu skryptu YafRay Export 0.0.2, który to uruchamiamy z poziomu 
menu Render paska narzędziowego programu (ilustracja 24.).

Większość obiektów na scenie jest do siebie podobna 
– chodnik, schody i ściany to materiały typu shinydiffusemat, 
dla których wystarczy wskazać odpowiedni stopień odbicia świa-
tła (parametr Diffuse reflection) i kolor (prostokąt Color). Nieco 
więcej wyobraźni wymaga przygotowanie cech powierzchni wóz-

ka oraz jego metalowych elementów. Dla pierwszego z nich jako 
rodzaj materiału wskazujemy glossy, ustalając poszczególne pa-
rametry (Glossy reflection – stopień refleksji powierzchni, Expo-
nent – wyrazistość odbić) analogicznie do ilustracji 25. Podobnie 
postępujemy w drugim przypadku, gdzie jako typ materiału wy-
bieramy coated-glossy (ilustracja 25.).

Scenę uzupełniamy o słońce (Sun), dostępną z poziomu me-
nu Toolbox. Ponieważ światłocień pełni w pracy ogromną rolę, na-
leży dołożyć wszelkich starań, aby jego promienie skierowane 
zostały na wózek w taki sposób, aby tworzone przezeń cienie od-
powiadały tym, jakie obecne są na fotografii Alexandra Rodchen-
ki. Siłę światła (Power), jego kolor (Light Color), jakość (Samples) 
oraz ostrość generowanych cieni (Angle) regulujemy również za 
pomocą skryptu Yafray Export 0.0.2 (ilustracja 26).

Pozostaje nam już tylko, ponownie korzystając ze skryptu 
silnika renderującego, ustalić cechy kamery, a dokładniej – wy-
musić na niej stworzenie głębi ostrości, a więc rozmycia elemen-
tów położonych na scenie najdalej. Kluczowymi dla tego efektu 
parametrami są Aperture Size, ustalający stopień owego rozmy-
cia oraz DOF Distance, wskazujący w jednostkach miary Blen-
dera miejsce, na którym skupi się ostrość kamery (ilustracja 
27.). Aby wprowadzić w nim precyzyjną wielkość, należy w try-
bie Edit Mode kamery włączyć obecny w oknie Camera przycisk 
Limits, dzięki któremu z obiektywu wyprowadzona zostanie pro-
sta. Wystarczy już teraz regulować parametr Dof Dist ulokowany 
w sąsiednim oknie Yafray DoF do czasu, aż symbolizujący punkt 
ostrości obrazu żółty krzyżyk nie znajdzie się na spadającym ze 
schodów wózku. Uzyskaną w ten sposób wartość należy skopio-
wać do parametru DOF Distance skryptu Yafray Export 0.0.2.

Jako metodę renderingu wybierzmy mapowanie fotonowe 
(Photon mapping) oparte na emisji ze źródła światła fotonów w 
liczbie ustalonej parametrem Photons (ilustracja 28.). Fotony te 
odbijają się od powierzchni obiektów, które to z kolei zostają roz-
jaśnione światłem dobitym. Ich dostatecznie wysoka liczba pozwa-
la na redukcję powstałych w ten sposób jasnych plam na ścianach 
brył, które to zostaną dodatkowo wygładzone za pomocą algoryt-
mu Final Gather (FG). Warto również pamiętać o uruchomieniu 
opcji Use Background, dzięki której wszystkie elementy na scenie, 
bez względu na położenie lampy, zostaną delikatnie oświetlone. 

Rysunek 22. Fryzura lalki przygotowana za pomocą zestawu 
wirtualnych narzędzi fryzjerskich widocznych w oknie Particle 
Edit Properties

Rysunek 23. Prymitywna, kanciasta sukienka posłuży nam ja-
ko podstawa dalszej edycji ubioru

Rysunek 24. Miejsce lokalizacji opcji uruchamiającej skrypt 
YafRay Export 0.0.2

Rysunek 25. Cechy powierzchni części metalowych (po lewej) 
oraz materiału tworzącego ściany i dach wózka (po prawej)

Rysunek 26. Po zaznaczeniu lampy na scenie i wciśnięciu 
przycisku Object>Light>Camera zyskujemy dostęp do parame-
trów określających cechy wybranego źródła światła

Rysunek 27. Ustawienia kamery w projekcie
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Ponieważ w naszym projekcie wykorzystaliśmy efekt głębi ostro-
ści, nieodzowne jest wprowadzenie możliwie najwyższych para-
metrów AA samples, odpowiadających za wygładzenie krawędzi 
na obrazie. Mało tego – proces ten, zwany antyaliasingiem, warto 
przeprowadzić kilkakrotnie dla generowanego obrazu, o czym de-
cyduje wielkość AA passes (liczba 0 oznacza jego przeprowadze-
nie tylko jednokrotnie). Liczbę próbek dla dodatkowych obliczeń 
wyznacza AA inc. samples, przy czym, jeśli rozmycia są dość du-
że (tak, jak w przypadku projektu Bad Mother), nieodzowne jest 
zwiększenie wartości AA Pixelwidth do co najmniej 2.000. Warto 
być jednak świadomym, iż liczba próbek dla antyaliasingu decydu-
je o długości renderingu sceny.

Uwaga – przed rozpoczęciem renderingu sceny warto upew-
nić się, czy wskazanym silnikiem renderującym z menu okna 
Render przycisków Scene ([F10]) jest rzeczywiście YafRay, a 
nie domyślny – Blender Internal.

zakończenie
Mam nadzieję, że powyższy opis okaże się przydatny początkują-
cym miłośnikom grafiki 3D, w szczególności zaś – Blendera. Projekt 
ten przygotowałem posiadając raptem nieco ponad roczne doświad-
czenie w grafice przestrzennej, co dowodzi, iż właśnie pomysł, a 
niekoniecznie wirtuozeria techniczna, jest kluczem do uzyska-
nia interesujących obrazów. W przypadku jakichkolwiek trudności 
z wyświetleniem zawartych w pliku .blend tekstur w czasie rende-
ringu, sugeruję ich wypakowanie i umieszczenie w dowolnym miej-
scu na dysku twardym. Warto również pamiętać, iż wyrenderowana 
scena nie jest finalnym owocem naszej pracy. Niejednokrotnie zda-
rzy nam się uzyskać nie w pełni satysfakcjonujące rezultaty, szcze-
gólnie w przypadku generowania materiałów pokroju włosów. Chcąc 
uniknąć kolejnych, długotrwałych obliczeń, warto czasami wyko-
rzystać programy do edycji grafiki 2D typu Gimp, aby przyciem-
nić, rozjaśnić, bądź rozmyć określone fragmenty sceny. Proces ten, 
zwany postprodukcją, jest naturalnym etapem pracy grafika 3D, 
zmierzającym do urzeczywistnienia naszych oczekiwań względem 
przygotowywanego przez nas wirtualnego świata. 

Autor

Rysunek 28. Ustawienia renderingu sceny


